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There are seven menus in the MiniTerm Application. This document gives a brief 
discussion of each of the menus. More information can be gleaned from the history file 
and the other documentation.

Last Change Dec 6,1988

The Apple Menu

The only Miniterm item under this menu is the "About MiniTerm..." item. 
Selecting this item pops up a dialog box which gives some hints on how to use 
MiniTerm and the Copyright Notice. The other items are desk accessories and (if 
running under Multifinder) the other active applications.

The File Menu

Start Text Capture... Choosing this item brings up a standard file dialog for 
chosing a file name/destination. After specifying a file name and clicking the OK 
button all input from the host computer is captured in the text file. This provides a 
means for logging a session. The item changes to Stop Text Capture. In order to 
close the log file it is necessary to select the Stop Text Capture item in the File 
Menu.

Start Text Upload... Choosing this item brings up the standard file dialog for 
selecting a file for output. Only text files will be shown. If a file is selected and the 
OK button clicked, the file will be transmitted character a time to the host. One 
character is sent each pass through the main event loop. After selecting this item its 
appearance changes to Stop Text Upload. Selecting this item closes the file and 
stops transmission to the host.

Text File Creator Selecting this item causes a hierarchial item to pop up. This 
"sub" menu allows you to chose the "Creator" for text files. The current choices are 
EDIT for the old apple edit program, MACA for MacWrite, MSWD for Microsoft 
Word, and MPS for MPW.

Text File Pacing... Selecting this item bring up a dialog box which controls the 
speed of text file uploads. The user can choose line pacing and the pacing 
character. The default is that line pacing is off and the pacing character is the colon. 
The user can also chose a delay between characters. Setting this to a value other 
than zero can greatly slow down the upload. Line pacing works by refusing to send 
any additional characters after a carraign return until the host has responded with 
the pace character.

Receive Xmodem...This choice brings up a standard file dialog box and allows the 
user to select a name and destination for a file to be received from the host. How 
the received file is interpreted depends on what options have been selected from 



the Xmodem Preferences hierarchial menu.



Send Xmodem... This choice brings up a standard file dialog box which will allow 
the user to select a file to be transmitted to the host via Xmodem. How the file will 
be transmitted depends on options made in the Xmodem Preferences menu.

Xmodem Preferences Selecting this item brings up a hierarchial menu which 
presents the user with a number of Xmodem options:

Macbinary If this option is selected then if Send Xmodem is selected all 
files will be available for transmission. The files will be packaged in 
MacBinary II format. If this item is selected and the user is receiving a file, 
the received file is checked for MacBinary format and if present decoded. If 
the MacBinary test fails the file is saved as received ie Straight Xmodem is 
assumed.

Text Choosing this item will only allow Text files to be displayed in the 
Send Xmodem dialog. In addition <cr>'s are replaced by <cr><lf> and the 
final Xmodem segment is filled with NUL characters. On reception 
<lf>'s ,NUL and CTL Z characters are discarded and the file is given the 
TEXT attribute and the default creator is assigned to the file.

Straight Chosing this item  will only allow text files to be displayed in the 
Send Xmodem... dialog. The file is sent as is (the data fork). On reception 
the file is stored as received as a TEXT file with the default creator.

Disable CRC This item forces a checksum to be used rather than the more 
accurate CRC error detection mechanism.

Fast Download This item offers a minimal improvement in throughput by 
ACKing a packet soon as it arrives and then dying if an error is detected. 
Best used if the Mac is directly connected to the host and running at high 
baud rates.

128 Byte Buffers Chosing this item causes 128 byte packets to be used. This 
is the standard for "pure" Xmodem.

1024 Byte Buffers Chosing this item will cause Miniterm to advertise that it 
understands the 1k xmodem protocol. This can yield significant performance 
increases if the host also understands and can use 1k packets.

1K Uses C Handshake If this selected and 1024 Byte Buffers is selected. 
Then the initial handshake will be the character 'C'.



If your favorite bulletin board supports 1k Xmodem you need to check with 
the sysop to select the appropriate handshake.

1K Uses CK Handshake If this item is selected and 1024 Byte Buffers is 
selected then the initial handshake will be the characters "CK".If your 
favorite bulletin board supports 1k Xmodem you need to check with the 
sysop to select the appropriate handshake.

Set Xmodem Timeouts...Selecting this item brings up a dialog which 
allows the user to select various timeouts. The defaults are 10 seconds which 
are generally sufficient with 128 byte buffers. Miniterm does not time each 
character but instead times the entire packet after receiving the SOH. If one 
k packets are used or the user is working across a packet switched network 
some experimention may be needed.

Page Setup... This item will bring up the standard Apple page setup dialog. After 
the OK button is selected another dialog is brought up. This dialog allows the user 
to specify if a header will be printed and allows the user to specify left and bottom 
margins and how tabs are to be interpreted. Miniterm only supports Monaco and 
Courier Fonts.

Print Text File...This item will bring up a standard file dialog box with only text 
files displayed. Selecting a file will cause the file to be printed using the 
information obtained from the Page Setup Dialog.

Upload Postscript File... This item will bring up a standard file dialog box 
showing only text files. The assumption is that the file selected contains pure 
PostScript code. This code will be sent to the LaserWriter NO error checking is 
done.

Launch... This item will bring up a standard file dialog which only lists 
applications. Selecting an application and clicking OK will cause the application to 
be "launched". Note that if the user is running under multifinder that MiniTerm will 
be terminated.

Create A Settings File... This item will bring up a standard file dialog box which 
will allow the user to select a filename/destination for a new file which contains the 
"state" of all of the MiniTerm settings. This file has its own "type" and double 
clicking a settings file will cause MiniTerm to be initialized with the stored 
settings.

Use a Settings File... This item will bring up a standard file dialog which will only 
list previously created settings files (and of course folders). Selecting a settings file 
and clicking the OK button causes the file to be read and the stored settings to be 
used. There are two exceptions, The port will not be changed and the Font selection 
will not be changed.

Default <- Current Settings Selecting this item causes the current settings to be 
stored in MiniTerm. When MiniTerm is restarted without selecting a settings file 
the stored default settings will be used.



Default <- Factory Settings Selecting this item causes the "Factory" settings to 
made the default settings. This does not take effect until the next time MiniTerm is 
launched. These settings are fairly standard. 1200 baud,8 bits, no parity, vt100 
font ,twenty four lines by eighty columns.

Quit  Selecting this item causes MiniTerm to shutdown. Text file send/receive is 
terminated and MiniTerm exits. The modem is not hung up.

The Edit Menu

Copy This item will copy selected text to the clipboard. Text is selected by 
pressing the mouse button and dragging over the desired text. A selection can be 
extended by holding down the shift key and pressing the mouse button. A single 
blank delimited word can be selected by double clicking on it.

Paste This item will cause the text contents of the clipboard to transmitted to the 
host. The text is sent one character at a time each pass through the main event 
processing loop. If the selection is exactly one line long a trailing <cr> will not be 
sent. This will allow command line editing. The line pacing and character delay 
will be used just as in a text file upload.

The Options Menu

Baud This item pops up a hierarchial menu which will contain the baud rate that is 
in use. The default is 1200.

Parity This item pops up a hierarchial menu which displays the current parity. The 
default value is "No Parity". The other choices are "Even" and "Odd". The host 
manager can tell the user which is the appropriate choice.

Data Bits This item pops up a hierarchial menu which displays the data size. The 
default is Eight Bits, this setting forces No Parity to be set. The other choice is 
Seven Bits. The host manager can tell the user which is the appropriate choice.

Flow Control This item pops up a hierarchial menu which displays the availability 
of XON/XOFF flow control. The default choice is "Enabled". This means that if 
MiniTerm receives a XOFF character that no more characters will be sent to the 
host until a XON character is received from the host. Also if MiniTerm's serial 
input buffer is nearly filled MiniTerm will send a XOFF character to the host as a 
signal to not send any more characters. When the serial buffer has more room 
MiniTerm will send  a XON character to the host as a signal that characters can be 
received again. If "Disabled" is picked flow control signals will not be generated or 
obeyed. Flow control is automatically disabled when receiving a file via Xmodem. 
Flow control is used if enabled while sending a file via Xmodem. Note that noise 
on the line could be mistaken for a XOFF character (that will never be dismissed !) 
This will have the effect of "locking" the keyboard. MiniTerm will beep if the user 
hits a key while in an XOFF state. The XOFF condition can be cleared by chosing 
the Unlock Keyboard item from the Options Menu.



BS This item pops up a hierarchial menu which shows how the Backspace Key 
(Delete on Mac II) will be treated. The default choice is to send the Delete 
character. The other choice will send a BackSpace character. (Option Backspace 
(Option Delete on Mac II) will always send a backspace character.)

Local Echo This item pops up a hierarchial menu which shows if keystrokes are 
echoed locally. The two choices are "Enabled" and "Disabled". The default choice 
is "Disabled". This is the proper choice for hosts which run in "Full Duplex" mode 
ie the host does the echoing. If the user is connected to a "Half Duplex" host then 
the user should chose "Enabled".

Show Clock Selecting this item causes the current time to be displayed in the 
Menu Bar. Selecting the item again causes the time display to be halted.

Unlock KeyBoard Selecting this item clears an XOFF state. See the discussion 
above under Flow Control.

Echo CR as CRLF Selecting this item which cause an incoming CR to be echoed 
as the pair of characters <cr> <lf>.

Read Statistics... Selecting this item pops up a dialog box which shows the 
maximum number of characters found in the serial port input buffer and the 
average number of characters returned by each read directed to the serial port. The 
counts are zeroed after the dialog is dismissed.

Interpret Controls If this item is checked, control characters are displayed 
graphically rather than executed. The font is forced to vt100. This choice is very 
useful in debugging protocol problems.

Reset Terminal Selecting this item causes the screen to be cleared and the 
scrolling region set to the entire screen. The cursor is also sent to the Home 
position.

Cursor Options... Selecting this item causes a dialog to appear. This dialog 
controls how the cursor is managed. The choices are underline (the default), or 
block. Blinking (the default) or non blinking. Visible ( the default) or invisible.

Track Cursor Selecting this item causes the cursor coordinates to be displayed in 
the lower left corner of the MiniTerm window.

The Communications Menu



Phone Manager... Chosing this item causes the phone manager dialog to appear. 
The phone manager allows a name and an associated string ( generally a phone 
number) to be stored as a resource in the MiniTerm application ( DIAL). When the 
phone manager is invoked the stored names are displayed in a scrolling list. 
Selecting a name will cause the associated string to be displayed. If the dial button 
is clicked the string will be prefixed by the Hayes command ATDT (ATDP if pulse 
is selected)  and the resulting string sent to the modem. Double clicking a name is 
the same as selecting a name and clicking the Dial button. If a name is selected and 
the Send button is clicked the associated string is sent without a prefix. This 
provides a primitive macro facility. If a name is selected and the Delete button is 
clicked the name and string are deleted. There is no auto redial capability or even a 
check to see if the modem is connected.

MiniTalk Manager... Chosing this item causes the Minitalk manager dialog to be 
invoked. Minitalk is an AppleTalk telegram service. It allows brief messages (255 
characters ) to be sent to other on line users of the MiniTerm application that are 
connected via Appletalk. When invoked the manager tries to find all of the online 
users of MiniTerm. Each user is known by the User Name field in the Chooser DA. 
This list of names is shown in a scrolling list. Selecting a name in the list selects 
the target user. The user can then type their message in the upper text edit box. 
Double clicking the name in the list or clicking the send button  or hitting the enter 
key will send the message to the selected target. Carriage returns can be used to 
send multiline messages. The message will appear in the lower text edit box at the 
target machine. If the target is not currently using the Minitalk manager a dialog 
box will pop up and display the message on the target machine. If appletalk is not 
active the Minitalk manager will not be available.

Priority Notification If this item is checked, MiniTerm will attempt to drive the 
MiniTerm application to the front window in case Miniterm is running in the 
background under multifinder and a Minitalk message has arrived. This feature 
may break in a future release of the Macintosh OS.
Dec 5,6 1988 Starting with version 2.9.6 of Miniterm I have added Notification 
Manager routines to advise the user that a message has arrived. The old method 
will be used if the version of the os does not support the Notification Manager. This 
should fix the problem mentioned earlier. If this item is selected Notification will 
also be provided when Xmodem transfers complete. (see the History notes)

The Fonts Menu

The first three items are the fonts that MiniTerm can use, Courier Monaco and 
vt100. Vt100 is the default. The vt100 font contains vt100 graphic characters and 
representations of the control characters. (But only comes in one size, 9 points) 
MiniTerm also contains a bold version of the vt100 font which is just as wide as the 
plain vt100 font. Chosing a font always selects the smallest real size available in 
the selected font family. The last items are the sizes that are available for each of 
the fonts. The real fonts are "outlined" and the user is only allowed to choose a real 
font. My personal preference is Courier 12.



The Port Menu

This menu is a pop up menu that is invoked by holding down the mouse button 
while the program is being launched. The two choices are "Modem Port" ( the 
default) and "Printer Port". Apple recommends that the Modem port be used 
especially at higher speeds.


